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1. Download 
 
The Global Plan to Stop TB, 2006–2015 sets out what needs to be done to achieve the 
Millennium Development Goal (MDG) and related Stop TB Partnership targets for TB 
control. These targets are to halve TB cases and deaths by 2015, compared to their level 
in 1990; to detect at least 70% of infectious cases; and to successfully treat 85% of 
detected cases. The Plan is based on the Stop TB Strategy, launched by the World Health 
Organization in March 2006, and is made up of plans and budgets for seven 
epidemiologically-defined regions of the world. The Plan has a price tag of US$ 56 
billion, including US$ 47 billion for control activities and US$ 9 billion for research and 
development.  
 
For the Global Plan to be successfully implemented, it is essential that country-level 
planning and budgeting for TB control is in line with the seven regional plans and 
budgets set out in the Global Plan; that country budgets for TB control are fully funded; 
and that all planned interventions and activities are fully implemented.  
 
This tool is designed to help countries develop plans and budgets for TB control at 
national and sub-national level within the framework provided by the Global Plan and the 
Stop TB Strategy. These plans can be used as the basis for resource mobilization from 
national governments and donor agencies.  
 
The tool is an Excel-based spreadsheet in which plans and budgets for all major 
components of the Stop TB Strategy can be developed. Accompanying documents and 
related links that will help users to understand and use the tool effectively are also 
provided on this site.  
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2. Key features of the tool 
 
Some of the key features of the tool are: 
 

• It is an Excel-based tool with an in-built user guide and menu system for 
navigating between worksheets and within worksheets; 

• There is one worksheet for each major component of TB control; 
• Each worksheet allows for detailed development of plans and budgets, or for the 

calculation of "Quick estimates"; 
• Each worksheet includes a ready-made list of likely inputs and activities to 

consider as well as default values, based on experience from a variety of countries; 
• The tool is flexible e.g. names of inputs and activities and default values can be 

modified as appropriate; 
• An "Application options" feature is included to enhance user-friendliness; 
• It includes historical epidemiological, demographic and financial data and 

epidemiological/demographic projections up to 2015; 
• It is designed to assist with projections of key indicators that underpin any plan 

and budget  e.g. the number of patients to be treated; 
• There is a status bar to show the status of work done within the tool; 
• Summary tables and figures are automatically produced.  

 
3. Benefits of using the tool 
 
Some of the benefits of the tool are: 
 

• It should save time and improve the quality of plans and budgets once an initial 
effort to understand and use it is made; 

• Because data are entered in Excel, plans/budgets can be easily revised or updated 
when necessary; 

• Much of the plan document itself can be produced by writing a written text 
description of what has been set out in the tool; 

• Plans and budgets for TB control set out comprehensively in one place; 
• It allows budgets to be presented in a standardized way, facilitating comparisons 

among and within countries 
• It automatically produces the financial information requested on annual WHO 

data collection form; 
• It provides a framework for monitoring and evaluation of TB control. 
 

These benefits arise because: 
• The tool provides a ready-made framework for planning and budgeting for all 

components of the Stop TB Strategy, in line with the Global Plan; 
• The tool provides a ready-made list of likely inputs and activities to consider for 

each major component of TB control, based on experience from a variety of 
countries. This can serve as a useful checklist when developing plans and budgets; 
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• Background epidemiological and demographic data are already integrated into the 
tool, helping with projections of indicators such as the number of patients to be 
treated and estimation of the first-line drug budget; 

• The tool includes a ready-made set of default values for indicators such as 
patients that will need to be treated, population size that will need to be covered 
by different interventions, and the unit costs of different interventions. These can 
provide a useful reference point for your own plans and budgets and can be used 
when you do not have any estimates of your own; 

• Summary tables and figures are automatically generated and can be used as the 
basis for resource mobilization including GFATM proposals as well as for 
reporting of financial data to WHO; 

• Data are entered in Excel, and can be easily revised or updated when necessary; 
• Much of the plan document itself can be produced by writing a written text 

description of what has been set out in the tool - for example, key components of 
a plan such as the goal, objectives and targets, strategies to be implemented, 
activities and inputs that are needed to implement strategies, and budget 
requirements and funding gaps, can be written based on the data entered in the 
tool; 

• Plans and budgets for TB control are set out comprehensively, in one place; 
• The tool makes use of information that is not always available at country level; 
• The tool is flexible - it can be adapted to country-specific needs; 

 
4. Powerpoint presentation explaining the tool (download) 
 
5. Related documentation and links 
 
Key reference documents and links are:  
 
The Global Plan to Stop TB, 2006-2015 
The Stop TB Strategy 
Planning frameworks for different components of the Stop TB Strategy developed for 
GFATM proposal development workshops 
Guidelines for conducting national disease prevalence surveys (in preparation) 
 
This additional documentation will help to answer questions such as: What is this 
component about? Where does it apply? How do I move forward if interested? 
(link with the pdf document) 
 
Links: 
  
Stop TB Partnership/ Global Plan website: http://www.stoptb.org/globalplan/ 
Stop TB Department website: http://www.who.int/tb/strategy/en/ 
Stop TB Department website: 
http://www.who.int/tb/dots/planningframeworks/en/index.html 
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6. Frequently Asked Questions (FAQs) 
 
1. Why was this tool developed? 
 
The Global Plan has set out what needs to be done to improve TB control and achieve 
international targets in the ten years 2006–2015 for seven regions of the world, based on 
the Stop TB Strategy. For the Global Plan to succeed, plans and budgets developed at 
country level will need to be line with the regional plans that make up the Global Plan. 
However, early assessment of strategic plans for individual countries for the period 2006 
onwards showed that national plans are not always in line with what has been set out in 
the Global Plan, especially for the newer components of the Stop TB Strategy (country 
plans tend to be less ambitious). The tool was developed to help countries develop plans 
and budgets that are in line with the Global Plan, as well as to develop budgets that can 
be used as the basis for resource mobilization from domestic governments and donor 
agencies.  
 
2. How was this tool developed? 
 
A proposal for development of the tool was submitted to TBCAP (TB Control Assistance 
Program), which is funded by USAID, in February 2006. This proposal was approved in 
March. A first draft of the tool was developed in April and May 2006. The starting point 
for development of the tool was the planning frameworks prepared by the DOTS 
Expansion, MDR-TB, TB/HIV and ACSM working groups for the Global Plan, and the 
planning frameworks prepared by staff from the WHO Stop TB Department for Global 
Fund proposal development workshops. This final version has been improved through 
field-testing in several countries including Indonesia, Kenya, Malawi, Myanmar, and 
South Africa, and practical application of the tool during planning workshops held in the 
Eastern Mediterranean region (9 countries) and Latin America (14 countries). It has also 
benefited from the input of many people who are closely involved in planning TB control 
activities at country level.  
 
3. Is the tool only available in English? 
 
No. The final version is available in English, French, Russian and Spanish.  
 
4. Do I need to be a computer expert to use the tool? 
 
No. Anyone with a basic knowledge of Excel can use the tool. See the "Basic tips for 
using Excel" section of this Sharepoint site for some tips on how to use Excel.  
 
5. Is it very time-consuming to enter the required data in the tool? 
 
Completing the tool does require investment of time. The actual amount will depend on 
factors such as the amount of work on planning and budgeting that has already been done 
for the period 2006–2015, the extent to which the strategies and related interventions and 
activities to be implemented have already been defined, and the extent to which TB 
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control needs to be improved to reach international targets. Field-testing and 
planning/budgeting workshops held so far suggest that about 1–2 weeks is needed to 
prepare a first draft for all relevant sections of the tool, followed by a period of 
discussions/review and finalization that should ideally be completed within 2–3 months. 
 
While probably requiring additional effort at the beginning, it should not be long before 
the tool saves time and improves the quality of planning and budgeting. This is because: 

• It provides a ready-made framework for planning and budgeting covering all 
elements of the Stop TB Strategy; 

• Background epidemiological and demographic data are already integrated into the 
tool, helping with projections of indicators such as the number of patients to be 
treated and estimation of the first-line drug budget; 

• Summary tables and figures are automatically generated and can be used as the 
basis for resource mobilization including GFATM proposals; 

• A ready-made list of likely inputs and activities is already provided, based on 
experience from a variety of countries, which can serve as a useful checklist when 
developing plans and budgets for different aspects of TB control; 

• Data are entered in Excel, and can be easily revised or updated when necessary; 
• Much of the plan document itself can be produced by writing a written text 

description of what has been set out in the tool - for example, key components of 
a plan such as the goal, objectives and targets, strategies to be implemented, 
activities and inputs that are needed to implement strategies, and budget 
requirements and funding gaps, can be written based on the data entered in the 
tool.  

 
Of course, the tool is just that, a tool. It is not an excuse not to think. In fact, the tool 
forces the user(s) to think hard about different aspects of TB control, and in doing so can 
help to improve the quality of planning and budgeting.  
 
6. What is the purpose of the link called "Application Options", which appears on 
the bottom right-hand corner of the Welcome page? 
 
In the default version of the tool, the sheet tabs as well as the column/row headers are 
hidden for presentational purposes. Furthermore all sheets are protected and the 
background data are hidden for security purposes. To be able to add rows, modify 
contents or enter formulae that include links with other sheets you will need to show the 
sheet tabs, unprotect the sheets and show the column/row headers. You can do this 
manually in each sheet (see also points 5–7 in "Trouble-shooting Tips").  
 
The "Applications Options" link allows you to simultaneously unprotect all sheets, show 
row and column headings in all sheets and show all worksheet titles, rather than doing 
this repeatedly in each page/sheet. You can do this by clicking on "Application Options", 
and then clicking on the different buttons, as appropriate.  
 
Please note that the Show/Hide data option is set to Hide. The data that are hidden and 
protected are background epidemiological and financial data for 211 countries in the 
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world. You should not need to work on these sheets, and it is advisable not to "Show" the 
data or to modify the data. If you want to change some of the values for your country, 
please change them in the page in which they appear, rather than in the "Background" 
data. 
 
7. Trouble-shooting Tips 
 
1. Macro security 
Q: When I try to open the tool in Excel, I get a warning message that macros are disabled? 
A: Close the planning and budgeting tool. Open a new book. Then, in Excel, go to the 
Tools menu and choose Macro, and then under Macros choose Security (Tools-Macro-
Security). Then select "medium" for your security level (if set to High or Very high, the 
tool will not work). When you reopen the tool, you will be asked if you want to enable or 
disable the macros. Always choose to "Enable macros". 
 
2. Automatic calculations 
Q: The tool is supposed to calculate many values automatically, and to automatically 
select the right country and region in each sheet/page once I've chosen my country on the 
Welcome page, but this isn't happening. 
A: Although this shouldn't happen, the setting within the tool for automatic calculations 
may have changed. Go to the Tools menu, then select Options, and then select 
Calculation (Tools-Options-Calculation). Make sure that the option "automatic" is 
selected. Another way to solve this problem is to press the F9 key. 
 
3. Changing the type of values that you are allowed to enter 
Q: When I try to enter a number into a cell, I get the message that "The value you entered 
is not valid". 
A: The values that can be entered in some parts of the tool have, in some cases, been 
deliberately restricted. This is to try to prevent incorrect data being entered. If you are 
sure that the data that you want to enter make sense/are correct, then you will need to 
"undo" the restriction that has been imposed on these cells. You can do this by 
highlighting the relevant cells using the mouse, then go to the Data menu, choose 
Validation, and then make sure that "any value" is the option selected under the heading 
"validation criteria" (Data-Validation).  
 
4. Subtotals that are automatically calculated for you need to be CHECKED and 
modified where appropriate WHENEVER you have added rows or inserted 
duplicate tables 
Issue: In all sheets of the tool, you may need to add rows and/or insert duplicate tables to 
reflect the range of activities or inputs that are needed in your setting.  
Q: If rows have been added, and/or duplicate tables added to a page/sheet, then the 
budgets for the items that you have added may not be included in the budget subtotals.  
A: You need to CHECK the formulae for any budget sub-totals that include the items that 
you have added. If the relevant rows/cells that you have added are not included in the 
formulae, you will need to modify the formula so that they are included. You can easily 
see which cells are included in any formula as follows: a) click on the cell that contains 
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the formula for a sub-total b) then, in the formula bar at the top of the screen, click at the 
end of the formula. Unless the formula is very complicated, all the cells that are 
contributing to the existing formula will be highlighted. Any items that you have added 
can then be included by adding the cell with the relevant total (or subtotal) to this formula. 
You can do this by typing a new "add" sign (+) into the formula bar at the top of the 
screen and then clicking on the cell that you want to add.  
 
5. Protecting and Un-protecting sheets 
Q: I want to add rows or change the wording of some rows, but when I try to do this I get 
the message that "The cell or chart you are trying to change is protected".  
A: In the default version of the tool, all sheets are protected. However, when using the 
tool you will need to modify the content of some cells (e.g. row titles), and you may want 
to add rows (for example so that you can insert duplicate tables). To be able to do this, 
you need to "unprotect" a sheet. You can do this by going to the Tools menu, choosing 
Protection, and then selecting "Unprotect sheet" (Tools-Protection-Unprotect Sheet). 
When you have finished entering data, you can choose to protect the sheet (Tools-
Protection-Protect Sheet). Another way to solve this problem is go to the "Application 
Options" in the tool on the Welcome page at the bottom right, click on it, and select 
unprotect sheets on the menu.  
 
6. Showing row numbers and column letter headings while entering or reviewing 
data 
Q: I want to check the row number of a cell of the letter heading of a column and/or I 
want to see the row number and column letter headings when checking a formula, but the 
row numbers and column letter headings are not showing.  
A: For presentational reasons, the default setting of the tool is such that column and row 
letter headings and numbers are not shown. You can change this by going to the Tools 
menu, then selecting Options, and then selecting View (Tools-Options-View). In the 
View menu, make sure that the box for "row and column headers" is ticked. Another way 
to solve this problem is go to the "Application Options" in the tool on the Welcome page 
at the bottom right, click on it, and select show/hide sheet headers on the menu. 
 
7. Entering a formula that includes a link to a cell in another page/sheet 
Q: I want to enter a cell from a different sheet into a formula, but I can't do this, I can't 
see the sheet. 
A: The tool is set up with a menu system such that the names of individual sheets are not 
shown at the bottom of the screen in the way that you would typically see them in an 
Excel workbook. If you are entering a formula in one sheet and you want to include a cell 
from another sheet in that formula, then you will need to change the way that the 
workbook is displayed. You can change this by going to the Tools menu, then selecting 
Options, and then selecting View (Tools-Options-View). In the View menu, make sure 
that the box for "sheet tabs" is ticked. Another way to solve this problem is go to the 
"Application Options" in the tool on the Welcome page at the bottom right, click on it, 
and select show/hide sheet tabs on the menu. 
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8. Tips for using Excel 
 
Excel is a package that has many features to facilitate data entry and analysis, including 
features that can save a lot of time. Listed below are a few introductory tips that you may 
find helpful when using the planning and budgeting tool. 
 
If you have other questions about Excel (of the How can I ….? or Can I….? kind) when 
using the planning and budgeting tool, please let us know and we will add the questions 
and solutions (if available) to the list provided below. 
 
1. Symbols used for calculations in Excel 
Mostly, the symbols that you need to use in Excel are the same as the mathematical 
symbols used in books or on calculators. One that is different is the symbol used for 
multiplication. In Excel, you use the * sign (i.e. an asterisk) instead of x.  
 
2. How to write a formula 
You can do calculations within Excel (you don't need to do a calculation on a calculator 
and then enter the value in Excel). For budgeting, it is likely that some calculations are 
going to be necessary. Instead of using a calculator, you can enter the formula for the 
calculation that you want to do in Excel. To do this, click on the cell where you want to 
enter a formula. Then type the "equals" sign followed by your formula. For example, if 
you know that the budget for a member of staff is US$1000 per month while the tool is 
asking you to enter the cost of that member of staff for one year, you can write =12*1000.  
 
3. How to look at which cells contribute to a formula 
It is often useful to check which cells are contributing to a formula. For example, you will 
need to do this in the planning and budgeting tool if you have entered new rows or 
duplicate tables, to check that any subtotals that are being calculated include the new 
costs that you have entered. To check which cells are contributing to a formula, first of all 
click on the cell where the formula is written. Then go to the formula bar at the top of the 
screen and click at the end of the formula. All of the cells that are contributing to that 
formula should then be highlighted (although if a formula is very complicated, this will 
not be possible).  
 
4. Dragging values across a row or down a column 
When you want to enter the same value more than once, you don't need to keep typing in 
the same number (or formula). You can simply use the mouse to drag the same value (or 
formula) across a row or down a column. To do this, click at the bottom right hand corner 
of a cell, and then drag the mouse across or down the screen.  
 
When dragging formulae, cell references to a column heading will be changed as you 
drag across a row (e.g. if the original formula was written as =e45, when you drag that 
formula across a row the next entry will be =f45), while references to rows will be 
changed when you drag a formula down a column (e.g. if the first cell has the entry =a55, 
the next entry will become =a56 when you drag that formula down a column).  
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5. Use of the $ sign in a formula  
Often, it will be important that some cell references are kept fixed when you drag a 
formula across a row or down a column. For example, suppose you have written the 
formula =c56*5 in a cell. You want the same number to appear in the next 8 rows. If you 
drag the formula c56*5, the next value will be c57*5, and the next c58*5, the next c59*5, 
and so on. This will be wrong if you need to keep the reference to cell c56. To ensure that 
the formula keeps the reference to cell c56 as you drag down a row, you need to enter the 
$ sign before the c i.e =$c56*5. Similarly, anytime you insert the $ sign before a letter 
reference (for columns) or before a number reference (for rows), then whenever you drag 
the formula those references will be "fixed".  
 
9. Feedback 
 
Please let us know what you think of the tool, both good and bad, including suggestions 
for improvement and comments on how you have used it. You can do this by sending an 
email to TBBUdget@who.int. We will try to answer any questions as soon as possible. 
 
10. Group discussion 
 
This space is designed to let all users interact and exchange ideas/comments, and to ask 
questions.  
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